
Masternode Setup Guide
(HOT+COLD Wallet setup with Vultr.com Linux VPS)

What is a masternode?

Masternodes are computers on the Rapture network that provide network services and facilitate PrivateSend
and InstantSend functionality. They also partake in the governance functions of the network and are allowed to
submit and vote on proposals for the network. A masternode should have a fixed ip address and a stable
uptime.

Since masternodes are allowed to govern and also facilitate transactions, there is a requirement for 1,000
Rapture to be held as collateral in order to operate a masternode. This makes it inherently difficult and expensive
for an individual to setup and operate a majority of the masternodes on the network.

Rapture masternodes need to run with what’s known as a hot/cold wallet setup. The basic premise is that the
“cold” wallet is your local computer and the “hot” wallet is a remote VPS (virtual private server). The cold wallet
effectively holds your 1,000 Rapture collateral and the rewards that are generated are sent to that wallet. This
wallet is (or should be) password protected and can be closed once the masternode is started. The “hot” wallet
is an empty wallet on the VPS. You don’t send funds to it and don’t even need to know its wallet address. It
remains unlocked, but also empty….so if your VPS is ever compromised, there’s no risk of losing funds.

With that said, let’s get onto the process of setting up a Rapture masternode…

NOTE - If you see any error messages while working through this guide or certain commands aren’t working,
please retrace your steps or stop in at our Discord channel for support.

https://discord.gg/NMgQEn8


Also, there are other setup guides out there and they take different approaches and place files in different
directories….jumping between guides is not recommended unless you’re an experienced Linux user and can
easily and account for the differences in paths and commands.

SCREENSHOTS SHOW v1.0.0 but the commands have been updated to v1.1.0.
BE SURE TO UPDATE YOUR LOCAL WALLET TO v1.1.0 PRIOR TO UPDATING THE MASTERNODE

Setup Guide

Step 1 - Setting up the collateral transaction

The first step involves sending exactly 1,000 Rapture to a new wallet address. You’ll want to have a small
amount above 1,000 Rapture to cover the transaction fee, so you’ll need to have a starting balance of at least,
say 1,001.00 Rapture. First, we’ll create a new wallet address to hold the 1,000 collateral. This will also be the
address that the masternode rewards are sent to.

In the QT wallet, choose:

File->Receiving addresses…

This brings up a list of the receiving addresses managed by your wallet.

Click +New



...and give it a label, such asMasternode1.

Click Ok to create the address. You’ll see the new address in the list, select it and choose Copy to store that
address in the clipboard.



Click Close to exit the receiving address dialog. Now we’ll send the 1,000 collateral amount to the address you
just created.

Under the Send tab, paste the address that you copied into the Pay To: field. The Label field should pre-populate
with the label you gave it earlier, in this case, Masternode1.

In the Amount: field, enter 1,000. Do NOT check “Subtract fee from amount” as this will subtract the transaction
fee from the Amount and your transaction will be below the required 1,000 Rapture.



Click Send and your transaction will be broadcast to the network. You’ll need to wait for 15 confirmations (the
current number of confirmations is viewable in the Transactions tab) before the masternode will fully activate,
but we can start working through the rest of the setup in the meantime.

Step 2 - Generate the masternode private key and txid

The next step is to enable the Masternodes tab in your local wallet and use the debug console to output a few
important details that we’ll need.

To enable the Masternodes tab in your local wallet, go to:

Settings->Options->Wallet->Show Masternodes Tab



Click Ok to apply the setting and then close and re-open your local wallet. After re-opening, you should see the
Masternodes tab which will display the full list of masternodes on the network, as well as masternodes
associated with your local wallet (My Masternodes is probably empty because we haven’t added one yet).

Next, we need to access the debug console to output what’s known as the collateral txid and themasternode
private key. The collateral txid is an identifier for the transaction of 1,000 Rapture that you made previously. The
masternode private key is a key that is specific to your wallet and is used to validate your masternode on the



network. Like any private key, you want to keep this secret...there’s no reason to share this number with anyone
or post it publically.

To access the debug console, go to:

Tools->Debug console

The debug console has a wide range of commands that provide all sorts of helpful information and provide
convenient functions. In this case, we’ll use it to obtain your masternode txid and private key.

In the debug console, type in:

masternode outputs

This will list all transactions that meet the parameters for starting a masternode. Since we sent a transaction to
a new local wallet address for 1,000 Rapture, we should see the transaction id listed here (if you’re not seeing
any output, verify that you have in fact sent a transaction to a local wallet address for exactly 1,000 Rapture):

Copy that output and paste it somewhere convenient (in an empty Notepad session is fine).

Next, we’ll generate a private key for you masternode. Type in:

masternode genkey

Copy and paste this number somewhere convenient as well, we’ll use it shortly. With these two numbers output
and pasted in a text document, we can proceed with the VPS setup.



Step 3 - Setting up a Linux VPS with Vultr.com

This part of the guide will take you through setting up a VPS with vultr.com. There are a few other good VPS
services out there, but Vultr has basic servers that can be run for $2.50/month and provide the resources
necessary to run a masternode.

https://vultr.com

Create an account with Vultr.com and setup a payment method. Once you’ve created an account with Vultr and
linked a credit card or payment method, navigate to:

https://my.vultr.com/

This is your main console for Vultr and where you can deploy and monitor servers. Click on the Servers tab on
the left. If you have servers running already, you’ll see them listed here and can click + to launch a new server.
Otherwise, you should already be seeing the server deployment page.

Choose a location:

https://vultr.com
https://my.vultr.com/


...and then choose a type. For Rapture, we want a 64-bit Ubuntu 16.04 x64 installation. Next, choose a Server
Size. The standard $2.50/month server should be adequate.

If it’s listed as Temporarily Sold Out:

...then scroll back up and choose a different location. It seems that the United States based locations have the
best availability in the $2.50/month server size.



All other options can remain at their defaults, but assign the server a hostname and label, in this case
‘masternode1’. Then click Deploy Now to launch your server.

You’ll be taken back to the list of your servers and you’ll see that the server you just deployed is installing. Once
it’s listed as Running, we can login for the first time.



We need to retrieve the login credentials for the initial login. Click on the name of the server, in this case
‘masternode1’.

This will bring you to the Server Information page for your VPS:

Down in the bottom left you’ll see the Username: root and Password. Click on the icon of the eye to reveal the
password for the root account. This is the set of credentials that we’ll use to login.

Step 4 - Logging into your VPS with PuTTY

To access the VPS, we need to use a protocol called SSH. An SSH session will give you command-line access to
your VPS and will be the mechanism we use for running commands on the Linux machine. We’ll use a program
called PuTTY. This is a popular and widely used ssh client in Windows. (For OSX users, you can use your
Terminal and just run the command ssh root@<YOUR VPS IP ADDRESS>)

The latest version of PuTTY can be downloaded from here:
https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html

...or the most recent version at the time of this writing, 0.70, can be downloaded directly from here:

https://the.earth.li/~sgtatham/putty/latest/w64/putty-64bit-0.70-installer.msi

Install PuTTY and run it from the Start Menu. Once open, you’ll see the standard PuTTy interface:

https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html
https://the.earth.li/~sgtatham/putty/latest/w64/putty-64bit-0.70-installer.msi


Under Host Name, enter the IP address for your VPS. In this case we use 207.148.28.6:

For convenience, you can also type a name (like “vultr masternode1”) under Saved Sessions and click save to
store your VPN details. Click Open and PuTTY will initiate the first connection to your VPS. You’ll likely see a
security alert listing the ssh key fingerprint, choose Yes.



Next up, you’ll see the login prompt for your VPS. The username is root and the password is the password that
was listed on your Server Information page in Vultr:

Note that in PuTTY, a right-click will paste the contents of your clipboard….so if you’re copying and pasting the
root password, a right-click will paste. You won’t see any *’s or feedback for the password when you paste it, so
just hit Enter after pasting. If you get an Access Denied message, double-check your root password and try
typing it in manually rather than pasting.

Step 5 - Setting up a new user account

Now that we’re logged in as root, the first thing we want to do is create a separate user to run the masternode
under. The root account has the highest level of system access and it’s generally not good to run as root if you
can avoid it, so let’s make a user named ‘rapturenode’.



adduser rapturenode

Assign a password that you’ll remember, and then accept the remainder of the defaults:

Next, we’ll give this user what’s known as sudo access. This allows that user to run commands with elevated
privileges and to do things like install software and system updates.

Type the following:

usermod -aG sudo rapturenode

You won’t see any output, but you’ve just given the user ‘rapturenode’ sudo access. Now we can logoff our root
account from the VPS and re-connect as our new ‘rapturenode’ user. Type:

exit

...to close the current ssh connection. This will drop you back to the main PuTTY interface. Re-connect to the
VPS the same way we did before, by typing the IP address into the Host Name field and click Open.

You’ll be presented with the login prompt again, this time we’ll log in as our ‘rapturenode’ user.

login as: rapturenode
password: <the password that you set earlier>



Step 6 - Installing Rapture and dependencies

At this point, you should be logged into the vps and at a command prompt. The first thing we’ll do is install
updates to Ubuntu. The installation and management of software in Ubuntu is done using the ‘apt-get’
command. First run:

sudo apt-get update

Enter your password if prompted. Then run:

sudo apt-get upgrade



This will list a group of packages in Ubuntu that can be upgraded. Type ‘y’ to start upgrading the packages. Sit
back and watch as packages and applications are updated. It may not look exactly like this, but you’ll see some
similar messages streaming by. Once that’s finished, you’ll be back at the command prompt.

Now we’ll install nano (a convenient text editor), git (a tool used for accessing github repositories) and fail2ban
(a tool to help keep the vps secure from false login attempts). Type in:

sudo apt install -y nano git fail2ban

Now it’s time to download the Rapture binaries. Type:

wget https://github.com/RaptureCore/Rapture/releases/download/v1.1.2.2/rapturecore-1.1.2-linux64.tar.gz

https://github.com/RaptureCore/Rapture/releases/download/v1.1.2.2/rapturecore-1.1.2-linux64.tar.gz


The wget command will download the binaries straight from github. The binaries are in an archive, so we need
to extract them using the command:

tar -xvf rapturecore-1.1.2-linux64.tar.gz

They’ll extract quickly, and we can delete the archive by running:

rm rapturecore-1.1.2-linux64.tar.gz

Step 7 - Editing rapture.conf and running Rapture

Now we’ll create a configuration file for Rapture that has a few important details. We’ll use a tool in Linux called
‘nano’ to edit the file.

First, we’ll create the data directory for Rapture. Type in:

mkdir ~/.rapturecore

This creates a directory for Rapture to store its configuration files, logs, and blockchain data. Next, we’ll create
the rapture.conf file that Rapture pulls its settings from. To do this, type:

nano ~/.rapturecore/rapture.conf



This will open an empty file in the text editor nano. Enter in the following lines (NOTE: Do not leave any trailing
spaces at the end of this file, this has caused issues for some users):

daemon=1

rpcuser=masternode1
rpcpassword=jBjOp412kaf431pS
externalip=207.148.28.6

masternode=1
masternodeprivkey=7qi5U5bxmQ48nBjvo4mPgBMNX9kUrKBJewb6hAFCvc53qjsMfYe
maxconnections=50

rpcpassword can be any combination of letters and numbers. You don’t need to remember this password and
won’t need to enter it anywhere. Just be sure to NOT use any special characters or symbols in here…..letters
and numbers only!

externalip should match the IP address of your vps

masternodeprivkey should match the private key that we generated earlier in the debug console.

Press Ctrl-O to “Write out” the file in nano and press Enter to accept the default path:

Then press Ctrl-X to exit nano. You should now be back at a command line and ready to start Rapture on your
vps. Type in:

~/rapturecore-1.1.2/bin/raptured



This starts Rapture and it should now be running in the background. If you ever need to restart your VPS or
restart Rapture, this same command can be used to start the Rapture daemon.

To send commands to Rapture, we use the binary rapture-cli. The same commands that are available in the
debug console of your local wallet are also available with rapture-cli. To check that Rapture is properly
connected to the network, type in:

~/rapturecore-1.1.2/bin/rapture-cli getinfo

This issues rapture-cli the ‘getinfo’ command, which lists some basic information. Mainly, we’re looking to see
that “connections” has at least 1 connection (hopefully more).

Another helpful command is:

~/rapturecore-1.1.2/bin/rapture-cli mnsync status

This checks the current status of the wallet sync. When you launch your local wallet, you’ll notice that it takes a
minute or so to catch up to the latest block and also sync important information about the network, such as the
current list of masternodes on the network. Your vps wallet does the exact same thing, but because it’s run
through the command line, there’s no status meter to watch. This mnsync status command can be run multiple
times to check how far along the sync is. You’re looking for the line “isSynced” to be true, which means that your
wallet is fully synced with the blockchain and network.



Step 8 - Creating masternode entry in your local wallet

With Rapture up and running on your VPS, we’ll jump back over to your local wallet to get it communicating with
the VPS. Keep your VPS PuTTY session up and running, we’ll be back to take care of one more important task
there shortly.

On your local wallet, we need to give it the configuration information for your masternode. This is done by
editing your masternode.conf file. This file is generally stored in %APPDATA%/RaptureCore/masternode.conf,
but an easier way to edit it is to go to:

Tools->Open Masternode Configuration file

This should open up your masternode.conf file in Notepad.

This file has an example line in that can be used as a guide. The # in front of the line indicates that it’s
“commented out”, which means it’s effectively ignored. Following this example, we see that the structure is:

alias - a name for your masternode
ip address - the IP address for your VPS that is hosting the node
masternode private key - the key that we generated previously using ‘masternode genkey’
txid - the transaction id for your 1,000 Rapture collateral transaction
index - the block position of the transaction…this is the number that appears at the end of of the txid listed by
‘masternode outputs’

Following this structure, for our example we’re going to add a line that looks like this:

masternode1 207.148.28.6:14777 7rDZwYbEfHoFpGHKPJ
e0c7a8b9ea61eea5d331c0f7553869b9a22d8d8c87cbd6d629c5f2997226d252 1



Double check your entries to make sure they all match up, and then Save and close notepad. Every time you edit
or make changes to the masternode.conf file (or any conf file), you need to close and re-open the wallet to
initialize the changes. So close your local wallet, and then re-open.

Once you’ve re-opened, over on the Masternodes tab you should see your node listed.

Click the Start alias button and then click Yes to confirm. (NOTE, before clicking start, make sure your
transaction of 1,000 Rapture has AT LEAST 15 confirmations, you can check the number of confirmations by
hovering the mouse cursor over the transaction in the Transactions tab)



This remotely connects to your VPS and uses your private key and txid to activate the masternode. If everything
has been configured properly, you should see the following message:

Step 9 - Setting up sentinel

At this point, your masternode has been enabled and will start broadcasting itself to the network, but will likely
be showing WATCHDOG_EXPIRED status.



There’s one more important step before your node is fully enabled and eligible for masternode rewards and
voting. We need to configure sentinel, which is a service that interfaces with the masternode. If this step is
skipped, your masternode will continue to display WATCHDOG_EXPIRED status and will not receive rewards….so
onwards with this important step!

Back over to your VPS now (if your PuTTY session disconnected, just reconnect and login with your
‘rapturenode’ user as before).

First, we want to install a package called virtualenv. From the command line, type:

sudo apt-get -y install python-virtualenv virtualenv

This should output some information and ultimately finish back at the command line.

Next we’ll clone sentinel from the RaptureCore github repository using the following command:

git clone https://github.com/RaptureCore/sentinel.git

https://github.com/RaptureCore/sentinel.git


This command places sentinel under ~/sentinel, so we’ll change to that directory:

cd ~/sentinel

Next, we’ll run a command to setup a python virtual environment in the sentinel directory. Type in:

virtualenv ./venv

This command creates a directory in your current sentinel directory that contains the python executables and

libraries. Next, we’ll install the requirements and dependencies for sentinel. Run:

./venv/bin/pip install -r requirements.txt



That will display information on the packages being installed and then drop you back to the command line. At

this point, we can run sentinel for the first time and make sure that it runs properly. Type:

./venv/bin/python bin/sentinel.py

When sentinel is running properly, it will process for a few seconds and then return to the command line without

any output. If you receive any error messages, take a look at the Troubleshooting section of the guide.

If sentinel runs without any errors, then we can proceed with the final step, which is setting up what’s known as a

cron job that schedules the sentinel command to run every minute. To create the cron job, we’ll run the following

command:

crontab -e

You’ll be prompted to choose an editor, we’ll use nano:

Down bellow all of the # (commented) lines, we’ll create a new line and insert (NOTE: If you selected a username

OTHER than ‘rapturenode’, edit this path and replace ‘rapturenode’ with your username. If you’ve deviated from

the guide and are logged in and installing as root, then the path should be /root/sentinel):

* * * * * cd /home/rapturenode/sentinel && ./venv/bin/python bin/sentinel.py >/dev/null 2>&1



This basically tells the sentinel command to run every minute. Type:

Ctrl-O and then Enter

to write out the file. Then:

Ctrl-X to exit



Step 10 - Wait for ENABLED status

At this point we’ve performed all of the steps in setting up a properly functioning masternode. It will take about

15-20 minutes for the node to switch over to ENABLED status:

Once it has switched to ENABLED, you can close your local wallet if you prefer. It does not need to be open in

order to receive rewards. If after about 20 minutes, you’re seeing anything other than ENABLED, proceed to the

Troubleshooting section below.



TROUBLESHOOTING

Sentinel debugging

The number one issue that users run into tends to be a misconfiguration with sentinel. It could be that the cron

task that keeps sentinel running in the background wasn’t setup properly, or it could be that sentinel wasn’t

installed properly to being with.

Checking the cron log

Whenever a cron task runs, it writes to the system log. You can easily check this by typing:

sudo grep CRON /var/log/syslog

This command checks the system log for entries with CRON in the name. You should see an output like this:

Here we can see that the cron task we setup in Step 9 is running every minute. If you’re not seeing something

similar, or you’re seeing error messages, go back to here and repeat the crontab procedure.

Checking that sentinel runs properly

We can double-check that sentinel is running without issue by running the following commands:

cd ~/sentinel

./venv/bin/python bin/sentinel.py

This should process for a second or two and then return to the command line without any messages or errors. If

you receive the message: Invalid Masternode Status, cannot continue….then your masternode was not

started successfully.

We can check the status of the masternode by running:

~/rapturecore-1.1.2/bin/rapture-cli masternode status



If the status says anything other than “Masternode successfully started”, try restarting the masternode by

clicking the Start all button on the Masternodes tab in your local wallet. Re-check the status by running the

previous command:

if all is configured correctly, then try running sentinel to verify that the problem is fixed:

./venv/bin/python bin/sentinel.py

Checking the masternode status

The status of the masternode can be checked on the VPS by running:

~/rapturecore-1.1.2/bin/rapture-cli masternode status

If everything is configured correctly, this should return the status: Masternode successfully started

If you receive another status, such as “Not capable masternode: Masternode not in masternode list”, check
the following:

- Click Start all from the Masternodes tab in your local wallet

- Verify that your collateral transaction of 1,000 Rapture has at least 15 confirmations. The masternode

will only start successfully once that transaction has 15 confirmations (you can check this by hovering

the mouse cursor over the transaction in the Transactions tab of the local wallet)

- Check your conf files for any errors



Masternode failed to start - CONF file errors

If you’re having issues starting the masternode via the Masternodes tab in your local wallet, best to check your
local masternode.conf file and your VPS rapture.conf file to make sure that they match up.

You can open your local masternode.conf file by choosing:

Tools->Open Masternode Configuration File...

...in your local wallet. On your VPS, you can open the rapture.conf file by typing:

nano ~/.rapturecore/rapture.conf

Arrange both of these side-by-side and double check that the IP address and masternode private key match.



UPGRADING

Upgrading masternode from v1.0.0 to v1.1.0

On February 22, 2017, a mandatory update was committed to the github repository bringing Rapture up to
v1.1.0. This update includes a re-balance between proof-of-work and masternode rewards after block height
29,000. As with any adjustment to block subsidies, the update is mandatory and users MUST upgrade both their
LOCAL and MASTERNODE wallets. The local update is very straight forward, just download your preferred
binary from:

https://github.com/RaptureCore/Rapture/releases/tag/v1.1.0

If you’re using the Windows installer, just install the new version and you should be all set. If you’re using the
zipped binaries, just delete your old rapturecore-1.0.0 directory and replace it with rapturecore-1.1.0.

To update your Linux VPS masternode, login to your VPS via putty (see the final commands in Step 5 if you
forget how to do this) and run the following commands:

First, download the v1.1.0 binaries from github:

wget https://github.com/RaptureCore/Rapture/releases/download/v1.1.0/rapturecore-1.1.0-linux64.tar.gz

Then extract those binaries:

tar xvf rapturecore-1.1.0-linux64.tar.gz

Next, we’ll shutdown the previous version of the Rapture daemon:

https://github.com/RaptureCore/Rapture/releases/tag/v1.1.0
https://github.com/RaptureCore/Rapture/releases/download/v1.1.0/rapturecore-1.1.0-linux64.tar.gz


~/rapturecore-1.0.0/bin/rapture-cli stop

Wait a few seconds for the previous daemon to fully shutdown, and then start up v1.1.0:

~/rapturecore-1.1.0/bin/raptured -daemon

You should now be running v1.0.0, you can verify this by running:

~/rapturecore-1.1.0/bin/rapture-cli getinfo

You’ll see the version listed as 1010000 and the protocol version as 70209.

At this point, head back over to your local wallet (which you should have already update to v1.1.0) and start your
masternode using Start alias:



Your node should show up as successfully started and will switch to PRE_ENABLED. PRE_ENABLED should
last for ~10 minutes and then switch to ENABLED.

You can double-check the status of the masternode on the VPS using:

~/rapturecore-1.1.0/bin/rapture-cli masternode status

The status should say “Masternode successfully started”. If the status reads as “Not capable masternode:
Invalid protocol version", make sure that the local wallet that you’re activating from has been upgraded to
v1.1.0. If so, then this message will clear momentarily and no additional actions are required.

When everything looks good, you can remove v1.0.0 binaries from your VPS by running (paste this exactly
as-is):

rm ~/rapturecore-1.0.0/bin/*

(NOTE, this command previously removed the entire rapturecore-1.0.0 directory, but several people have their
sentinel directory under there rather than in their home directory, so this version leaves any other data under
rapturecore-1.0.0 in place).

At this point, you’re fully updated to v1.1.0 and ready for block 29,001!



APPENDIX

Understanding your Masternode
Information provided by Discord users @secsi#1493 and edited by @RaptureDev#7473

Masternode Status

ENABLED: Working properly.

WATCHDOG_EXPIRED: Sentinel is not reporting properly. Check crontab -e and ensure all install file paths are
correct. Specifically the path to sentinel needs to match your sentinel location. Find the full path to sentinel by
typing: cd ~/sentinel;pwd

WATCHDOG_EXPIRED Troubleshooting can be found here

NEW_START_REQUIRED: Several possible causes. Try restarting the alias and wait up to 30 minutes for
ENABLED. If not begin troubleshooting.

PRE_ENABLED: New starts require time (approximately 10 minutes) to connect to peers and verify connection,
be patient.

Real-time Masternode status can be checked online here:
http://explorer2.our-rapture.com/masternodes
https://masternodes.online/monitoring/

Local Wallet Terminology

Collateral Transaction: This is the amount of coins required to operate the Masternode. 1000 RAP are required
for a Rapture Masternode.

[Sending your Collateral Transaction]: You must send exactly 1000 coins to generate a valid Transaction
ID(txid) to be used for a Masternode. (When sending a transaction to yourself you will see it in your history
"payment to self"as a small fee. 1000 coins will not show here.)

Transaction ID(txid): This value is generated when you successfully send exactly 1000 RAP to your new
receiving address. This process ensures you only have 1000 RAP in the specified address and allows the wallet
to lock those funds in place. These will now be used for your Masternode Collateral.
vout: This can be confusing to understand. This number is often 0, 1 or 2.
(The... blockchain uses a per-output transactional model, in which every transaction has a set of inputs and a
set of outputs. Each input “spends” one output of a previous transaction, with the blockchain ensuring that this
output cannot be spent elsewhere. The full history of transactions forms a multiway connected chain... All of the
[assets] in a transaction’s inputs flow into that transaction, which are then distributed across its outputs in
accordance with the quantities written within. As a result most regular payments require two outputs – one with

http://explorer2.our-rapture.com/masternodes
https://masternodes.online/monitoring/


the intended amount for the recipient, and the other containing “change” which goes back to the sender for use
in a subsequent transaction.)

Private Key: This is essentially a password that your VPS will use to access your local wallet and verify your
Collateral Transaction. KEEP THIS SAFE. DO NOT SHARE IT. PEOPLE CAN ACCESS YOUR WALLET WITH
THIS KEY.

VPS

A VPS is essentially a computer you rent. There are several providers to choose from. I personally use
DigitalOcean but Vultr is widely used as well.
($10 free credit at Digitalocean with this referral link: https://m.do.co/c/22b7cd6629d3 )

Renting a VPS is vital to running a Masternode to ensure security/stability/quality of life. When running a
"hot/cold wallet" you are able to close your wallet and turn off your local machine while the Masternode stays
active. Masternodes also require a static IP and broadcast their IP address to the network.For this reason it's
best not host from your local machine.

Hot/Cold Wallet: This term refers to your VPS and Local Machine respectively. Your VPS(Hot) will run your
Masternode and stay online while your Local wallet(Cold) is free to go offline.

Vultr
DigitalOcean
Time4VPS
Amazon EC2
Google Cloud Compute

Putty

Putty is a tool used to access your VPS via ssh. You can input your IP address and connect remotely through
the Putty console. This program is relaying the information you provide to your VPS. It allows you to act as if you
were sitting in front of a keyboard at your hosts site. The latest version of Putty can be downloaded here:
https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html

Ubuntu Commands

adduser : creates a new user profile
usermod -aG sudo rapturenode : gives user profile (in this case, 'rapturenode') admin power
exit : closes current ssh session
sudo apt-get update : updates the list of packages and versions listed by the apt repositories
sudo apt-get upgrade : upgrades any packages that have a new version reported by apt-get update
sudo apt install -y nano git : installs nano, a text editor, and git, a tool for downloading github repositories
wget : downloads from the specified target
~/rapturecore-1.1.0/bin/rapture-cli mnsync status : Because the VPS wallet does not have a visible progress
bar, we use this command to see the current state of synchronization.
crontab -e : edits the cronjob file. Cronjobs are automated request that you setup. In this instance we ask the
cronjob to tell the sentinel command every 60 seconds.

https://www.vultr.com/
https://m.do.co/c/22b7cd6629d3
https://www.time4vps.eu/
https://aws.amazon.com/ec2/
https://cloud.google.com/compute/
https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html

